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Webmail

Online email or webmail is email that you access online through Internet Explorer or your web browser, rather
than downloading it to your computer (like through Outlook or another email client). The advantage of
webmail is that you can access your email anywhere as long as you have an internet connection, the major
disadvantage is that you cannot access you email if you can’t get access to the internet. Most webmail
providers allow you to access their service from your web browser (Internet Explorer), and email client
(Outlook) and from your mobile phone.

Webmail is available for free from a number of online providers Google search [free email] and you’ll get 876
million results, or more. If you have an internet access account you may also receive free webmail through
your internet provider.

Two most commonly encountered email addresses are Microsoft’s @hotmail.com (now known as Windows
Live Mail)and Google’s @gmail.com. Both operate in more or less the same way. Set up as many email
accounts as you desire, you may want one email address to give out to people you trust, and another email
address to give to computers, web pages and other places you are likely to receive unsolicited mail from.

All online email is stored on an internet server somewhere in the world, you can usually store hundreds, if not
thousands of email messages within your webmail inbox indefinitely. Even deleted messages are kept for at
least 18 months for legal reasons (even if you delete the email and empty your trash). Email also has tracking
information hidden within it, so the whole history of where an email has been and who has read it can be
retrieved. Your email is protected by some sort of privacy policy, dependant on which provider you use as to
how secure that privacy policy is. Police or investigators usually need search warrant to access email without
your permission, but be careful what you say, as it may be used against you.

As for choosing which provider is right for you, it is a matter of both personal preference and is the email
address you want available with that provider. For example emailaddress@hotmail.com may be taken, but
emailaddress@gmail.com may not. Most free webmail services generate their revenue from advertising, so
expect ads targeted at you based on your internet browsing habits.

This manual describes how to use Gmail, Hotmail and webmail in general. There are some minor differences
between the layout of the screen from one provider to another, but in general they all have the same
functions and operate in the same fashion.

The sign up process for webmail can be slow and annoying, but be persistent and patient. Try and try again,
make sure you write down your passwords and login name (or email address) exactly as you typed them in (ie:
upper/lower cases, spaces, etc).
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Gmail - Create an account

Web Images Videos Maps News Shoppini Gmail riore~ Signin & From the GOOgle homepage click on the item [Gma|I] in the
S

black band at the top of the page.
Google

: , In the bottom right corner of the screen
Australia New to Gmail? It's free and easy.
click the [Create an account] button.
| Create an account »
About Gmail ~ New features!
Google Search I'm Feeling Lucky

Get started with Gmail Getting started involves choosing a username and password.
First name: [Vour This process is slow and annoying. Do not press the [ENTER]
Last name: [Name key, use [TAB] key or click the mouse to move between fields.
Desired Login Name: Iyourname @gmail.com

X Saz JSStR Johi-Sri Enter your [First name] and [Last name] in the required fields,

_check avaliabily | these will be used in your emails you send to people so be

ot ook mptain ] Hamore e sensible. As will your [Desired Login Name]. This is the most

- ) important field as this will be your email address @ gmail.com

youmame.name :
€ yname302 fOI’ a“ time.
© yn65409

' ynyourname3

Click the [check availability!] button.

In the example shown above the email address [yourname@gmail.com] was not available, and Gmail
suggested alternatives. Acceptable alternative Login Names would also possibly be; your_name, your.name,
yourmiddlename or yourname042175983 try and make your Login Name unique to you but also easy to

remember. You may not be able to get uniquename@gmail.com and uniguename@gmail.com without getting
creative with your name as well.

You may also be asked for your date of birth. There is a minimum age requirement to have a Gmail account.
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Gmail - Passwords

Click on the [Password strength:] link for tips on choosing a

Choose a password: " Password strength
Minimum of 8 characters in lengt password. Typically the harder to remember you make your
Re-enter password: | password the harder it will be for other people (or computer
W' Stay signedin programs) to guess.

' Enable Web History Leam More

— : 5 Make a list of your passwords, on paper, your phone, even on
ecurity question: Chi tion - . .
o ot st oo we il ack o he v v the computer, do it now and keep it secure and do not lose
on. L M
— your password.

Answer: l

Recovery email: I

If you are using a public computer, or a computer shared with other users, you may wish to remove the tick
beside [Stay signed in] by giving the tick a click.

Security question: | Write my own question _'_I 7
e There is a password recovery process, you can choose a

Whatis the name of your best friend from childhood?  security question and an answer that only you are likely

What was the name of your first teacher? . .

What is the name of your manager at your first job? to know, but will never forget. Click [ChOOSQ a

What first ph ber? . .
e S = question...] and from the drop down menu click on a

What is your vehicle registration number?
W"‘e"‘ oD ”es"°” question or write your own. You will also need to enter

an answer.
[Recovery email:] If you do not have access to another email account, leave this field blank.

Word Verification:  Type the characters you see in the picturs below.  The pext, and possibly the most frustrating part of the

Wﬁ process, is [Word Verification:] you need to decipher a string
of letters (in this case [digolowa] | think) and enter them in

& the box to the left of the handicap logo ( &).

Do not click the & logo unless you already want to become confused and annoyed. The idea is the computer
will attempt read the letters out to you using clear, computer synthesized, American accented voice. It usually
will confuse and annoy you instead, do not click the & logo.

Gn"l il Introduction to Gmail

T — The next step is to agree to the [Terms of service:] by clicking
the [l accept. Create my account] button near the bottom of
the page.

e Archive instead of delete

Tidy up your inboy
anything. You car
= what you need or

“ Quite often this process will fail for some reason or another,

3 m Chatang video cat usually the [Word Verification:] will not agree with your
interpretation. Or perhaps you didn’t enter the same password
: e twice. In any case, check every field you have entered carefully,
| weesemews o re-enter your password and repeat as required, then have
another guess at the [Word Verification:] click the [I accept].
Create my account] button near the bottom of the page again

gle - Tems & Privacy

and hope for the best.
You will see something like this when you have successfully created your Gmail account.

Click on [Show me my account>>] button to access your Gmail.
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Gmail - Inbox

= i Briefly this is what you get;

Click here to enable desktop notifications for Gmail. Learn more Hide

[Inbox], This is your email, click on an
item to read it.

[Delete] and email from your [Inbox] by

% RIS R AR R A s «» Clicking the
I : . [Delete] button above or below the
Make cal rightrom Gmail @ email list to move unwanted email to

Call riends and family around the world at
insanely low rates.

the [Trash] folder.

Tryitnow | Leam more

[Trash] folder contents will be removed

from [Trash] and deleted permanently within a predetermined timeframe or upon your command.

Side panel has other functions you maytneed, including the all important [Compose mail] button, [Inbox],
[Sent Mail], [Drafts] and [more]; where you.will find [Junk] and [Trash].

To view messages in any of your folders listed.on the side panel, just click on their name, and the messages
within will be displayed.

This is an ad, you can close this one and there are others, don’t get distracted.

Gmail — View message

If you’ve got mail, click on it to open and you should be presented with something like this.

4 || awcnwe | spam | Detete || 6| || Movetoy | Laveisy || e Read the message and admire the picture (if appropriate).
hello % 1abox | x (=]

to me (1 hour ago) Repl
see atched e [View] the attachment on a separate page.

e [Download] the attachment to your computer.
e [Reply] to the sender of the message.

= e J Blue hills j ..
26 Ve Doomiond e [Reply] usually does not resend original
attachment(s).

R e [Forward] the message on to other recipients.
‘ e [Forward] does send all attachments.

To save an attachment in Hotmail the process is slightly different from Gmail, right click the attachment, then
click [Save As], choose a location like libraries or USB, enter a filename, then click [Save].
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Gmail — Compose mail

Click the [Compose mail] button

Learn Local Mornington Peninsula Network

T send Sav Discard  Draft autosaved at 5:27 PM (1 minute ago) Lol Enter the email address of

ontacts

Tasks To: emailaddress@gmail.com the reCipient in the [TO:]

Compose mail box in this example
Add Cc | Add Bee . .

Inbox (3) [emailaddress@gmail.com]

Buzz ® Subject: attention: gmail

Starred 7¢ & ¥ Chiysanthemum jpg (image/jpeg) 859K . o

Important Attach another file Enter a brief description

[S):;'SMG': BZ UFTRHD: @ CEEE@G:s==1 check spetingy  Of your email in to the

| have Gmail email

[Subject:] box

Send ve Discard  Draft autosaved at 5:27 PM (1 minute ago)

The body of the email is contained in the white box Located underneath the [B/U] bar;
BZUFERD - =EEEEKES ST Pl chekspalingr ; enter some information into the body of the email even if
it is just to say [see attached].

Normal word processing options like bold and feats are available, but if you want a fancy looking message use
a word processor like Microsoft Office Word 2010 and attach it as a Word Document or a PDF document.

Check each component of your email; Your email gets automatically saved to the [Drafts] folder from
e Recipient’s address time to time until you send it. Then it moves to the [Sent Mail]
e  Subject folder.
e  Body of email

e Attachments (if any) Then click the [Send] button at the top or bottom of your

message.

Your message should then move from the [Drafts] folder to
the [Sent Mail] folder.

Attachments

Click the [Attach] or paper clip button [#] to attach a
picture or another document to you email.

<« Pictures » Sample Pictures

File Edit View Tools Help

Organize v =] Preview v Share with v Sideshow » & v [0 @
¢ Favorites % Pictures library el e You will presented with the file browser or [Windows
B Desktop Sample Pictures
 Downloads Explorer].

% Recent Places

®
3
.

Find the file you want, perhaps one of the samples in the

M 4 Libraries
8] ument Chi themum D flowers - C . . . .
Wil E— = il pictures library, then double click it.
&) Pictures e = . . . X
H videos " - — The file will then begin to upload this may take some
o i N = » time, especially for video. There are better methods of
f omputer ¢ B . .
& oRvEQ ﬁ h m sharing video.
€ Network & Koala Lighthouse Penguins

- Chrysanthemum Date taken: 14/03/2008 1:59 PM You should notice your attachment’s name and size
JPG File . .
. _ displayed above the body of the email.

Take note of the size of the attachment usually displayed as (K) Kilobytes (Kb) or (M) Megabytes (Mb) this
works out to something like (1000Kb = 1Mb). Try to keep your total attachment size as low as possible, it is
preferable to send several smaller emails than one really large one. If your total size is under 5Mb it should be
accessible by anyone with email access.
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Windows Live Mail — Inbox

Folders

mm j ®

Emall  Photo Rems

messape emad

All M (1
Drafts
Important
Sert Mad
Spam
Starred
Trash
Jonk E-mad
Personal
Recepts
Travel

Work

Madd
Calendae
] Contacts
E) Feeds

® Newsgroups

View

Delete

Accounts

LI

Reply Reply Forward

OO

Learn Local Mornington Peninsula Network

»

- P riag ») Copy to

Py b G0 Watch

Addto Umread/ Move o Send/  Work
lendae resd  to AR Encoding VNG~ pecewe - offine

Emailing: Manual-Windows7_v2011Aug30

Add ¢
Sgmail.cony

) Manual-
(W5 4] indows?
~011Aug0.

Your message is ready to be sent with the following file or
link attachments:
Manual-Windows7_v2011Aug30

cotact

Cgmalcom

Note: To protect against computer viruses, e-mail programs
may prevent sending or receiving certain types of file
attachments. Check your e-mail security settings to
determine how attachments are handled.

& L

4 September »

$ 67
13K
PVO2ANARBN

X089

Today

Ribbon Tabs — options of Home, Folders, View, Accounts

Send/Receive — icon to send and receive emails

Reply — to automatically reply to an email received
Forward — to send an email to someone not the sender
Add to Calendar - appointments, meetings, tasks, bookings

List of email folders — Drafts, Sent Mail, Spam (Junk Mail), Trash (Deleted mail) ...
List of emails received — emails you have received. Highlighted in black — unread. Listed in grey —

1.
2. Home Ribbon
3.
4,
5.
6.
7. Inbox
8.
9.
read mail.
10.
11.
12.
13.

Preview of email selected — click on a message in list to see a preview
Calendar - click on a date to view calendar activities for that day
Preview list of events — preview of activities for Today

Work offline — stops Windows Live Mail from attempting to connect to the Internet while you work.
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Windows Live Mail — New Message

1 1 5 | NewMessage ESE—)

tessage Insert Options @ @ w
® . e (ES HE 1 58

= Emoticon ~
Plain Attach Photo , Add Check Delivery Spelling

text file album & Other~ names

From . ,Ggm.ut(om v

l/

To

o =

Bee

Subject @

NounkwNgRE

10.
11.

12,

13.

14.
15.

Ribbon Tabs - Message, Insert, Options

Message Ribbon — options

Send button — click to send your completed message.

Check Names — checks the name of the message’s recipient against the names of your Address Book

Spelling — runs a spell-checking tool through your completed message.

Attach file — Use this to include (‘attach’) a file to your email, such as a word document or picture file.

Delivery — add a flag to your email to indicate it’s important. Choose from High Importance, Low
Importance or Read Receipt (return email to advise recipient has opened your email).

Insert -> Signature — applies a digital signature to the message, which allows the recipient to verify
your identity

Options -> Encrypt — encodes your message so that it cannot be read while it is in transit to the
recipient.

To: Enter the recipient’s email address in this field.

Cc ... Carbon copy. Enter the addresses of additional recipients you would also like to receive a copy
of the message

Bcc ... Blind carbon copy is entering addressing in a way that conceals multiple addresses from all the
other recipients.

Subject Type a short description of what the message is about.

Account From Designate which account when you have more than one email address

Message Space Type your message in this space.
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Windows Live Mail - Received message window

OL

hl

— ™
X (@ v | Class exercise ) 4 Lo 1 ) i

,, @@

@ e ¢ = > P P e ::::u-t {}
lunl Dcme

Class oxor(ist

)
B)

Reply Reply Forward Addto Move Copy Flag Watch gous Ne
@ all - calendar  to to ..7 Encoding e
Bgmai.com Add contact @

kﬂ ClassExerciseP @
AEL.doc

Regards from

PwnNPE

v

Message title bar quick launch icons and title of message

Ribbon - Message options,

Reply — Opens a new message window with the sender’s name automatically appearing in the To field

Reply all - As for Reply but also replies to any people who were initially included as carbon copy (Cc)
recipients of the original message

Forward — Opens a new email message window with the original message and attachments included.
The To field will be left blank so you can choose who to forward the message on to.

Print — click on the drop down arrow and choose Print to print the message
Delete — removes the message from its current folder and moves it to the Trash folder
Previous — opens the previous message of the folder you are currently in.

Next — opens the next message of the folder you are currently in.

Junk — where all mail designated as Junk are stored before sending to Trash

From — displays the name of the person who sent the message

Date — displays the date the message was sent

To —displays the address(es) of the recipient(s), usually including you!

Subject — displays the topic of the message

Attach — displays the name of any files included with the email.

Message — displays the test of the message
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71 [ 4 ) 7 | Contacts- Windows Live Mai =
Home
= = 4 N 13 Edit category | [==4 § Sortby v = AL F]
. . . R P, Bttt | [G2) 3 & [
WlndOWS LIVE Mall - FOlderS Contact Category Itﬂ : T Imp?r( Exp?ﬂ Directories sign
Mail — a view of all emails received. « Contacts
ontacts (0)

Hlconit Name * Personal email From Company Birthday

Calendar - store all appointments, tasks, etc You have o contacs
Toseeyour contactsfrom Windows lee sign in with your Windows Live ID.

Contacts — store all contact details like postal S
addresses, phone numbers, email addresses, [ Contacts
company names, job titles, etc. o

* Newsgroy,

Add » Comtact — -
2
. . . .
Windows Live Mail - To add a new Contact — ‘
1. Click on the Contacts folder 5 =
2. Fill in the details you require in Quick add, Contact,
Personal, Work, etc
3. Click on Add contact
4, This information can be retrieved at any time from your
Contacts folder.
£3d contact Concel

Mornington Peninsula Quality Pre-Accredited Network
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Email etiquette (Netiquette)

While sending emails and newsgroup messages is similar to sending letters, there are some protocols that
should be observed.

e Spelling, grammar and punctuation are just as important in an email as in letter writing or a phone
conversation. Avoid ‘texting or SMS’ shortcuts like gr8 (great) or ur (You're). Be polite and respect the
person or people you are emailing, it is very easy to abuse or insult someone via email, just because
you can’t see them and are not likely to ever meet them does not mean you can show them any less
respect that anyone else.

e Using all capital letters is like SHOUTING in real life. Don’t do it unless there’s a very good reason!
Emails cannot capture your tone of voice, sense of humour or wry laughter. Check your email to
ensure that what you’ve said won’t be misunderstood. You can express emotions with simple symbols
like © or ;) but you should avoid this sort of thing in a formal email, like a job application for example.

e [tis okay to send your mates personal messages, jokes or funny pictures via email, but be careful
about using your work email for this purpose, most employers frown upon using business email for
private purposes, they may even monitor your workplace email usage.

e Emails are great for sending on funny pictures and files to your friends — but check the size of the
attachment before you send them. Sending large attachments/emails can cause your computer and
your recipient’s computer to slow down and it may take a long time for it to upload through the
internet and download to the recipient’s computer. If you have to send a large email then it is best to
check with the recipients first so that they know why their computer is so slow.

e If you are emailing to multiple recipients, typing their addresses in the Bcc (instead of To or Cc) will
mean that the recipients will not see each other’s email addresses at the top of your message.
Privacy of individual’s information is highly prized these days. People don’t like to share their
information with anyone they don’t know.

e If you are forwarding on an email be aware that the full history of whom it has been sent to in the
past (with the exception of Bcc recipients) is also forwarded on. You may wish to copy and paste the
content of the email to a new message to avoid this.

Malicious Attachments

When receiving email with attachments think about who sent the message and what the attachment may
contain before opening it. It is possible to receive a computer virus or other malicious software through an
email attachment. It is always good practice to have antivirus software that is capable of checking your email.
Always be careful before opening any attachments, ensure that you trust the person who sent the email, and if
in doubt don’t open it. Some email systems do not allow the sending of these types of files as attachments due
to the risk involved.

Some attachments that could possibly cause harm to your computer include ‘.exe’ or application files, ‘.bat’ or
script files, ‘.zip’ or archive files even a word document can have macros included in it that could be could be
considered malicious amongst others. Safe attachments include PDF files, pictures, sound and video files.

Spam/Junk Mail

Spam is unsolicited email sent by unknown senders. Rule of thumb —if you are in any doubt about the sender,
just delete the email. Send to Trash or add to Junk emails from now on. Always check you Junk emails before
deleting in case a legitimate email has been inadvertently sent there. Then delete all.

To avoid receiving unsolicited emails, you need to be very careful with your email address. Any time you type
your email address into a website to sign up for newsletters, special deals or other features, you may be
opening yourself up to spam. Before you give your email to any business or website, check it’s privacy policy.
Do not reply to spam emails in any way or click on their ‘remove from mailing list’ or ‘unsubscribe’ links. This
will confirm that your email address is active and that you are a ‘live’ target.
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